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The following tools and methods help you debug Microsoft Windows CE
operating system (OS) modules and components:

• The kernel debugger debugs code in the Windows CE kernel as well as
Windows CE applications.

• Debug zones provide a way to selectively turn the debug message output on
and off using macros. This allows you to trace execution of the code without
halting the Windows CE OS.

• The Windows CE Debug Shell tool (Cesh.exe) downloads binary files to a
target device using either a parallel or serial port connection and provides
remote file system capability. It can be used alone to get process, thread, and
debugging information.

The kernel debugger and application debugger have the following differences:

• Kernel debugging requires a special OS that must be compiled in debug mode.
Any application that you want to debug with the kernel debugger must be
started manually.

• When you quit the application being debugged on the device, the kernel
debugger still remains active.

• The application remains open on the target device when a stop debugging
command is performed in the kernel debugger.

• The user can debug dynamic-link library files (.dll) with the kernel debugger
when the executable file (.exe) is contained in ROM, for example Control
Panel applications.

The following illustration shows the scope of the kernel debugging versus
application debugging.

Related Topics
Using the Debugger

Debugging a Platform
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Building a Debug Version of the Kernel
A debug version of the kernel is necessary before you can use the kernel
debugger. The following table shows the appropriate values to set for these
variables before you run Build to create a debug version of the kernel.

Variable Value Description

IMGNODEBUGGER Undefined This setting instructs the Make Binary Image
tool (Makeimg.exe) to use Nk.exe, which
contains kernel debugging information, to
generate the binary image file Nk.bin.

1 This setting instructs Makeimg.exe to use
Nknodbg.exe, which does not contain
debugging information, to generate the binary
image file Nk.bin.

WINCEDEBUG Debug This setting  instructs Platform Builder to
disable any compiler optimization, to generate
debugging information in object files, and to
place object files in a Debug directory..

Retail This setting instructs Platform Builder to
allow compiler optimization, which are
incompatible with the debugger, and to not
generate debugging information in object
files. Platform Builder places object files in a
Release directory.

IDE Procedures
To build a debug version of the kernel

IDE Procedures
•• To build a debug version of the kernel

1. Choose Settings  from the Platform menu.

2. Select the General tab and select Debug from the Build Type  list.

This sets the WINCEDEBUG variable to Debug.

3. Select the Environment tab.

4. Select IMGNODEBUGGER in the Environment Variables list. Delete any
data in the Value box.

5. Choose Set.
6. Select Build from the Build menu.

Related Topics
Building a Debug Version of the Kernel
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Using the Kernel Debugger
You can use the kernel debugger to debug application code in the Windows CE
kernel. The kernel debugger must have access to an application’s symbols to
perform symbolic debugging on the application. Symbols for the modules are
contained in the program database file (.pdb) files located in the directory
%_FLATRELEASDIR%. A .pdb file is used by the build tools to store
information about a user’s application. Using it speeds linking during the
debugging phase of development by keeping the debugging information separate
from the object files.

If you want symbols for an application that has an extension other than .dll or
.exe, make a copy of the application with the extension .dll in the same directory
as the original application. For example, if you want symbols for Main.cpl, make
a copy of it in the same target directory as Main.cpl and call the file Main.dll.

The following screen shot shows the Debug toolbar.

IDE Procedures
To start kernel debugging

To stop kernel debugging

To run until a breakpoint is reached

To run to the cursor location while the debugger is running but stopped

To run to the cursor location in the disassembly code while the debugger is
running but stopped

To run to the cursor location in the call stack code while the debugger is running
but stopped

To run to a specified function

To set the next statement to execute while the debugger is running but stopped

To set the next disassembly instruction to execute while the debugger is running
but stopped

Related Topics
Using the Debugger
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IDE Procedures
•• To start kernel debugging

1. Choose Start Debug from the Build menu.

2. Choose Go.

•• To stop kernel debugging
• Choose Stop Debugging from the Debug menu.

Control returns to Platform Builder.

•• To run until a breakpoint is reached
1. Set a breakpoint.

2. Choose Start Debug from the Build menu.

3. Choose Go from the Start Debug menu.

•• To run to the cursor location while the debugger is running but stopped
1. In a source file, move the insertion point to the location where you want the

debugger to break.

2. Choose Run To Cursor from the Debug menu.

•• To run to the cursor location in the disassembly code while the debugger is
running but stopped
1. In the Disassembly window, move the insertion point to the location where

you want the debugger to break.

2. Choose Run To Cursor from the Debug menu.

•• To run to the cursor location in the call stack code while the debugger is
running but stopped
1. Select the function name in the Call Stack window.

2. Choose Run To Cursor from the Debug menu.

•• To run to a specified function
1. Enter the function name in the Find box on the Standard toolbar.

2. Choose Run To Cursor from the Debug menu.

You can use the Run To Cursor command to return to an earlier statement to
retest your application, using different values for variables.
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•• To set the next statement to execute while the debugger is running but
stopped
1. In a source window, move the insertion point to the statement or instruction

that you want to execute next.

2. Click the right mouse button.

3. Choose Set Next Statement from the shortcut menu.

•• To set the next disassembly instruction to execute while the debugger is
running but stopped
1. In the Disassembly window, move the insertion point to the disassembly

instruction you want to execute next.

2. Click the right mouse button.

3. Choose Set Next Statement from the shortcut menu.

The Set Next Statement command causes the application counter to jump to
the new location. Because the intervening code is not executed, you should
use this command with caution. You can also use the Set Next Statement
command to skip a section of code and continue debugging other sections, for
example, a section that contains a known bug.

Related Topics
Using the Kernel Debugger

Setting Breakpoints
Use the Breakpoints dialog box from the Breakpoints command on the Edit
menu to set, remove, disable, enable, or view breakpoints. The breakpoints you
set are saved as a part of your project.

You must have a project open before you can set a breakpoint. With no project
open, the Breakpoints command does not appear on the Edit menu.

You can set breakpoints at a source-code line or in the Disassembly window or
Call Stack window. If you set a breakpoint at a line with an NOP instruction in
the Disassembly window, an error will occur.

IDE Procedures
To set a breakpoint at a source-code line

To set a breakpoint at the beginning of a function

To set a breakpoint at the return point of a function

To set a breakpoint at a label
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IDE Procedures
•• To set a breakpoint at a source-code line

1. In a source window, move the insertion point to the line where you want the
application to break.

If you want to set a breakpoint at a source statement extending across two or
more lines, you must set the breakpoint at the last line of the statement.

2. Choose the Insert/Remove Breakpoint button from the Build toolbar.

A red dot appears in the left margin of your source code, indicating that the
breakpoint is set.

•• To set a breakpoint at the beginning of a function
1. Enter the function name in the Find box on the Standard toolbar.

2. Choose the Insert/Remove Breakpoint button from the Build toolbar.

A red dot appears in the left margin of your source code at the beginning of
the function, indicating that the breakpoint is set.

•• To set a breakpoint at the return point of a function
1. Start debugging, and pause the debugger in break mode

In break mode, the debugger waits for user input after completing a
debugging command.

2. Choose Debug Windows  from the View menu, and then choose Call Stack .

3. In the Call Stack window, move the insertion point to the function where you
want the application to break.

4. Choose the Insert/Remove Breakpoint button from the Build toolbar.

A red dot appears in the left margin of your source code, indicating that the
breakpoint is set.

•• To set a breakpoint at a label
1. In the Find box on the Standard toolbar, enter the name of the label.

2. Choose the Insert/Remove Breakpoint button from the Build toolbar.

A red dot appears in the left margin of your source code at the line containing
the label, indicating that the breakpoint is set.

Related Topics
Setting Breakpoints

Viewing and Enabling Breakpoints
If you set more than one breakpoint on a line, and some breakpoints are disabled
while others are enabled, a gray dot appears in the left margin in the Source
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window, Disassembly window, or Call Stack window. The gray dot does not
apear in the Breakpoints dialog box. The first time you choose the
Enable/Disable Breakpoint button from the Build toolbar, all breakpoints on the
line are disabled, and the gray dot changes to a hollow circle. If you choose the
Enable/Disable Breakpoint button again, all breakpoints on the line are enabled,
and the hollow circle changes to a red dot.

An asterisk (*) in the breakpoint check box indicates that the breakpoint is not
supported on the current platform.

IDE Procedures
To view the list of current breakpoints

To disable a breakpoint in a source code window

To disable a breakpoint in the Breakpoints dialog box

To enable a breakpoint in a source code window

To enable a breakpoint in the Breakpoints dialog box

To remove a breakpoint in a source code window

To remove a breakpoint in the Breakpoints dialog box

To remove all breakpoints

To view the source code where a breakpoint is set

IDE Procedures
•• To view the list of current breakpoints

1. Choose Breakpoints from the Edit menu.

2. Use the vertical scroll bar to move up or down the Breakpoints list.

•• To disable a breakpoint in a source code window
1. Move the insertion point to the line containing the breakpoint you want to

disable.

2. Click the right mouse button, and then choose Disable Breakpoint from the
shortcut menu.

•• To disable a breakpoint in the Breakpoints dialog box
1. Choose Breakpoints from the Edit menu and find the breakpoint in the

Breakpoints list.

2. Clear the check box next to the breakpoint that you want to disable.

3. Select OK.
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For a location breakpoint, the red dot in the left margin changes to a hollow
circle.

You can also use the SPACEBAR to toggle the state of one or more breakpoints
in the Breakpoints list.

•• To enable a breakpoint in a source code window
1. Move the insertion point to the line containing the breakpoint you want to

enable.

2. Click the right mouse button, and then choose Enable Breakpoint from the
shortcut menu.

•• To enable a breakpoint in the Breakpoints dialog box
1. Choose Breakpoints from the Edit menu and find the breakpoint in the

Breakpoints list.

2. Select the check box next to the breakpoint that you want to enable.

3. Select OK.

For a location breakpoint, the hollow circle in the left margin changes to a red
dot.

You can also use the SPACEBAR to toggle the state of one or more breakpoints
in the Breakpoints list.

•• To remove a breakpoint in a source code window
1. Move the insertion point to the line containing the breakpoint you want to

remove.

2. Choose the Insert/Remove Breakpoint button from the Build menu.

– Or –

Click the right mouse button, and choose Remove Breakpoint from the
shortcut menu.

•• To remove a breakpoint in the Breakpoints dialog box
1. Choose Breakpoints from the Edit menu

2. Select one or more breakpoints in the Breakpoints list.

3. Select the Remove  button or press DELETE.

4. Select OK.

For a location breakpoint, the red dot in the left margin disappears.

•• To remove all breakpoints
1. Choose Breakpoints from the Edit menu.

2. Select the Remove All button.
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The red dots in the left margin change to hollow circles.

•• To view the source code where a breakpoint is set
1. Choose Breakpoints from the Edit menu

2. Select a location breakpoint in the Breakpoints list.

3. Select the Edit Code  button.

This action takes you to the source code for a breakpoint set at a line number
or function name. In the case of function names, the debugger must be
running for this to work.

Related Topics
Viewing and Enabling Breakpoints

Stepping Into, Over, and Out of Functions
When debugging, you have a choice of stepping into, stepping over, and stepping
out of a function. The Step Into command causes the debugger to execute the
next statement and then pause. If the next statement is a function, the Step Into
command causes the debugger to enter the function and pause at the beginning it;
the Step Over command causes the debugger to execute the function and to
pause after the function is completed. The Step Out command causes the
debugger to finish executing the current function and to pause when the function
is exited.

IDE Procedures
To run the application and execute the next statement

To step into a specific function

To step over a function

To step out of a function

IDE Procedures
•• To run the application and execute the next statement

1. Choose Step Into from the Debug menu while the application is paused in
break mode.

The application is paused in break mode when it is waiting for user input after
completing a debugging command.

The debugger executes the next statement, then pauses execution in break
mode. If the next statement is a function, the debugger steps into that
function, and then pauses execution at the beginning of the function. If you
step into a nested function call, the debugger steps into the most deeply nested
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function. For example, on the line of code Function1(Function2), the
debugger steps into the function Function2, then pauses.

2. Repeat step 1 of this procedure to continue executing the application one
statement at a time.

•• To step into a specific function
1. Set a breakpoint before the nested function call.

– Or –

Use the Step Into, Step Over, or Run To Cursor command to advance the
application’s execution to that point.

2. In a source code window, select the function that you want to step into.

3. Choose Step Into from the Debug menu or from the shortcut menu.

The debugger executes the function call and pauses execution at the beginning
of the selected function.

You can use Step Into for any number of nesting levels. You can also use Step
Into with a C++ member function.

•• To step over a function
1. Open a source file, and start debugging.

2. Execute the application until it reaches a function.

3. Choose Step Over from the Debug menu.

The debugger executes the next function, but pauses after the function
returns.

4. Repeat step 3 to continue executing the application one statement at a time.

•• To step out of a function
1. Start debugging, and execute the application to some point inside a function.

2. Choose Step Out from the Debug menu.

The debugger continues until it has executed the return from the function, and
then it pauses.

To avoid slow execution, do not step out of a function containing a loop. Instead,
you set a breakpoint at the end of the function, and then choose Go from the
Debug menu to execute to the end of the function. Then choose Step Out from
the Debug menu.

Related Topics
Stepping Into, Over, and Out of Functions
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Debugging Processes and Threads
The Processes command on the Debug menu displays the same information as
the Cesh.exe command, gi all (get all information). Before you can use the
Processes command, you must stop the process that is running on the target
device by entering the Break  command from Platform Builder.

Each process report has the following fields:

Process
The name of the process.

Process ID
The system identifier for the process.

Base address
The address where the process was loaded. The linker typically picks an
arbitrary base address that it uses to link and that you can see in the mapfile
file (.map). The loader sets process modules to this address. In Windows CE,
all processes are loaded at 0x10000.

Access key
The access key bits needed for a thread to be able to see the address space of
this process. This corresponds directly to the index entry of the process.

Debug zone
The current debug zone setting in effect for this process. This relates to the
DEBUGZONE bits and the DBGPARAM structure.

Process address
The base address for the process in the global virtual address space of the
target device.

Process Struct
A pointer to the entry for this process in the process table, which is
maintained inside the kernel.

In addition to these entries, each process can have any number of threads
associated with it. Windows CE allows up to 32 processes. Each thread has the
following fields:

Thread ID
The system identifier for the thread

Thread priority
Bits 4 through 7 of this value represent the current priority, which is the
priority at which the process is currently running. Bits 0 through 3 represent
the base priority, which is the priority at which the process runs if no
inversion is occurring. Typically, the base priority and current priority are the
same value.
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Access key
The access keys for the current thread. This field is not valid for the currently
running thread. If the thread is inside a protected server library (PSL), the
access key includes permission bits for the owner process and the PSL
process.

Thread state
The following table shows the thread states.

Value Thread state Description

0 Thread is running The thread is currently running

1 Thread is runnable The thread is currently runnable and will run
when the OS reaches the next time slice at that
thread’s priority.

2 Thread is blocked The thread is blocked on a resource, which may
be one or more events; mutexes, or critical
sections

3 Thread is suspended The thread has been suspended by a call to
SuspendThread

4 Thread is sleeping. The thread has called the Sleep function

5 Thread is blocked
and sleeping

The thread is blocked on a resource, which may
be one or more events; mutexes, or critical
sections and the thread has called the Sleep
function.

If you entered the debugger by entering Break  at the Windows CE>
prompt, you are in the thread for Shell.exe (the debug shell).

Queue
Unused and is always zero.

Current process
The address of the process in which the thread is currently running

You can use this field to determine if a thread is inside a PSL by comparing
the translated value to the pProcess field values of the processes listed in a
PSL. For example, to translate the value of pCurProc for the file system
(0x2c5fce9a), perform the following steps.

1. Set the high nibble of pCurProc to 0x8 (value is now 0x8c5fce9a)

2. Add 0x16 (value is now 0x8c5fceb0)

3. Display the DWORD value at the calculated address. In this example, at the
prompt Windows CE>, enter dd 0x8c5fceb0 l1.

The current address space is the one corresponding to this process. To look
at variables in other address spaces, map the variable’s address, as described
in the lpvAddr section.

Note
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Suspend count
Unused.

Sleep count
Unused.

Getting a Stack Traceback for a Thread That Is Not Running
Sometimes you need to get a stack traceback for a thread that is not running,
such as when you are trying to debug a deadlock condition or when the target
device stops responding.

IDE Procedures
To get a stack traceback for a thread that is not running

IDE Procedures
•• To get a stack traceback for a thread that is not running

The following example is for an SHx CPU. The names of member fields pointed
to by pThread->ctx vary depending on the CPU type.

1. Choose Processes from the Debug menu to review the thread structure in the
kernel, and then double-click the thread.

If pThread->pcstkTop is not NULL, the thread has gone through some
process transitions. If you dump the stack, you can see the pProcess and the
return address within that process. This can give you an indication of what is
happening.

2. Review pThread->ctx->fir by choosing Processes from the Debug menu and
double-clicking the thread.

pThread->ctx->fir is the return address where the stack traceback starts This
address is often inside coredll.dll. Pthread->ctx->R15 is the current stack
pointer.

3. Choose Debug Windows  from the View menu, and then choose Call Stack
to see the contents of the stack. for Pthread->ctx->R15.

Check that the current return address is mapped correctly. If it is not in a
DLL, offset it by the value of lpvAddr of the current process.

4. Choose List Nearest Symbol from the Debug menu and enter the address to
get the name of the function and its starting address in the current frame.

The List Nearest Symbol command will display the nearest function or label
before and after the address that is entered.

5. Choose Debug Windows  from the View menu, and then choose
Disassembly to show the binary code for the start of the current function.
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You are now looking at the prologue for this function. Scan the first few
instructions for a number that looks something like fffffxxx. This is the size
of the frame allocated by this function.

6. Scan down the stack by the size of the frame to find the next return address.

7. If there are more return addresses, return to step 2 of this procedure.
Otherwise, you are done.

Related Topics
Getting a Stack Traceback for a Thread That Is Not Running

Interpreting Output From the Modules Command
Choosing Modules from the Debug menu displays information about the DLLs
that are loaded into memory. The following output is typical, with the path
location corresponding to %_WINCEROOT%\Release.

Module Address Path
--------      -------- ------------  -------------------
COM.DLL 01F80000 - 01F8A000 C:\WINCE212\RELEASE
OBJSTORE.DLL 01F90000 - 01F9D000 C:\WINCE212\RELEASE
AUDIO.DLL 01FA0000 - 01FAB000 C:\WINCE212\RELEASE
KEYBDDR.DLL 01FB0000 - 01FB9000 C:\WINCE212\RELEASE
TOUCHDR.DLL 01FC0000 - 01FCA000 C:\WINCE212\RELEASE
UTIL.DLL 01FD0000 - 01FDA000 C:\WINCE212\RELEASE
COREDLL.DLL 01FE0000 - 01FF5000 C:\WINCE212\RELEASE
INIT.EXE 04010000 - 04018000 C:\WINCE212\RELEASE
GWES.EXE 06010000 - 060B5000 C:\WINCE212\RELEASE
OBJSTSVR.EXE 08010000 - 0805E000 C:\WINCE212\RELEASE
INITOBJ.EXE 0A010000 - 0A01E000 C:\WINCE212\RELEASE
SHELL.EXE 0C010000 - 0C01D000 C:\WINCE212\RELEASE
NK.EXE 8C040000 - 8C0A0000 C:\WINCE212\RELEASE

The address consists of two parts: the base address and the limit address. Use the
base and limit addresses to determine whether or not you are inside a DLL. These
addresses specify the areas of the global virtual address space reserved for each
DLL. Note that the base address for processes is the same as the value of the
base address field in the Processes command output.

Debugging Global Variables
In addition to the global variables of the current process, you can also review
global variables of any module that that is loaded, if you qualify the name with the
context operator. For example, no matter what the current process is, you can
examine the PROCARRAY structure in the kernel by typing the following text in
a Watch window:
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{,,nk.exe}ProcArray

Another method of reviewing modules is to cast a thread address. For example, if
you want to look at the thread structure for the Shell.exe process from the
Processes command output and its process address is 0:0x08cbe0a5, type the
following command in the Watch window:

 (PTHREAD)0:0x08cbe0a5c

IDE Procedures
To view loaded symbols

To load the symbols of a module

To load the symbols of all modules

Related Topics
Formatting Characters for Watch Variables

IDE Procedures
•• To view loaded symbols

1. Start a debugging session.

2. Choose Modules from the Debug menu.

•• To load the symbols of a module
1. Choose Settings  from the Project menu.

2. Choose the Debug tab, and then select Additional DLLs from the Category
list.

3. Select the empty rectangle in the Modules box to browse for the module you
want to load.

4. Choose OK.

•• To load the symbols of all modules
1. Start a debugging session.

2. Choose Reload from the Debug menu.

Related Topics
Debugging Global Variables
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Handling an Exception
The following table shows some of the exceptions that the kernel debugger can
handle.

Exception Processor exception Description

STATUS_DATATYPE_MISALIGNMENT MIPS: 4, 5

SH3: 0x0e0, 0x100

An address is unaligned. Verify that
all data references are aligned and that
the process is in the correct mode,
either User or Kernel.

STATUS_ACCESS_VIOLATION MIPS: 1, 2, 3

SH3: 0x40, 0x60, 0xa0,
0xc0

An attempt was made to access data
through a bad pointer, or you do not
have permission to access the object
to which the pointer refers.

STATUS_BREAKPOINT MIPS: 9

SH3: 0x160

A breakpoint was generated by a call
to DebugBreak.

STATUS_ILLEGAL_INSTRUCTION MIPS: 10

SH3: 0x180, 0x1a0

The microprocessor has tried to
execute an unknown instruction or an
instruction that is invalid in a delay
slot. This exception will only be
encountered if you are writing
assembly language.

STATUS_INVALID_DISPOSITION NA The structured exception handler code
called a handler to handle an
exception, but the handler returned an
erroneous or unknown disposition.

IDE Procedures
To view or modify the list of exceptions

To handle an exception

IDE Procedures
•• To view or modify the list of exceptions

1. Choose Exceptions from the Debug menu.

2. To modify an exception, select it in the Exceptions box, select an action
under Action, and then choose Change.

•• To handle an exception
1. Examine the output on the Debug tab of the Output window.

The output in the Output window indicates where the exception occurred.

2. Choose Go Handled from the Debug menu to let the kernel debugger handle
the exception.
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The kernel debugger executes the instruction again that caused the exception.

3. If the kernel debugger cannot handle the exception, select Go Not Handled
form the Debug menu to direct the kernel debugger to find a handler to
processthe exception.

If the kernel debugger cannot find a handler, it tries to handle the exception.
Go Not Handled terminates the process that owns the thread from which the
exception is generated.

The kernel debugger does not contain reentrant code. If the kernel debugger is
busy when an exception is raised, it blocks any user-mode threads—except
kernel faults—in order to handle the exception. If the kernel debugger is busy
when a kernel fault occurs, it exits. If the debugger is not busy, kernel faults
are handled normally. When the kernel debugger is no longer busy, it services
the user-mode threads.

4. Choose Go to resume, if an exception occurs but choosing Go Not Handled
does not cause the system to resume.

5. Choose Debug Windows  from the View menu and then choose Call Stack .

6. Double-click on any line to display the source code corresponding to that
frame.

7. Choose Debug Windows  from the View menu and then choose Variables to
view transient parts of the code, such as local variables.

You cannot see local variables through either a Quick Watch dialog box or a
Watch window.

Avoid keeping the Call Stack window open while executing code. Each time you
step, the kernel debugger must evaluate the Call Stack window again.

Related Topics
Handling an Exception

Kernel Debugging Using Standard Ports
The kernel debugger requires a dedicated physical transport. Typically this
transport is either a serial connection or an Ethernet connection, and is supplied
on an add-on debug board provided by an OEM. However, these debug boards
are not available on all devices, and typically they are not provided to independent
software vendors (ISVs) by an OEM. To address this, an OEM I/O controller has
been defined that you can useto dynamically switch a standard port, such as
COM1:, from normal mode to debug mode. This document describes the basic
mechanism for implementing this feature.
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IOCTL_SET_KERNEL_DEV_PORT
The IOCTL_SET_KERNEL_DEV_PORT I/O controller is defined in Pkfuncs.h.
Once you have fully implemented this I/O controller, you can create an
application that dynamically switches a port between standard and debug modes
by means of the I/O controller.

The parameters to IOCTL_SET_KERNEL_DEV_PORT are a kernel service
identifier and a kernel port identifier. The kernel service identifiers are part of the
Ethernet debugging support and are defined in Pkfuncs.h. The currently
supported services are KERNEL_SVC_DBGMSG, KERNEL_SVC_PPSH, and
KERNEL_SVC_KDBG. The port identifiers are device-specific and can be
defined in any device file.

A Windows CE PC-based hardware development platform (CEPC)defines seven
unique port identifiers: KERNEL_PORT_NONE, KERNEL_PORT_COM1,
KERNEL_PORT_COM2, KERNEL_PORT_COM3, KERNEL_PORT_COM4,
KERNEL_PORT_LPT1, KERNEL_PORT_LPT2, KERNEL_PORT_ETH1. You
must define only the available ports and PORT_NONE for a device.

Not all services need to be supported. For example, a basic implementation might
support only mapping the kernel debugger to the primary serial port. An advanced
implementation might also allow mapping any kernel service to a built-in Ethernet
port.

Handling the I/O Controller
Because switching ports for a mode is best accomplished by rebooting, the first
step in implementing the DEV_PORT is to provide an area to store the requested
mode that is preserved when you reboot, such as the driver global or other
reserved area of memory. Three bytes are required for storage—one byte for
each kernel service. Each byte contains the port identifier of the port used by that
service .

Once the data structure has been defined, modify the OEMIoControl function in
the OEM adaptation layer (OAL) to handle this I/O controller. An example of this
can be found in %_WINCEROOT%\Platform\Cepc\Kernel\Oal\Oemioctl.c. Model
your code after this example, substituting the appropriate port identifiers. If a
request is made to associate a service with an inappropriate port, use return with
ERROR_INVALID_PARAMETER. Cesh.exe cannot be associated with serial
ports and multiple services cannot share a single serial port. It is legitimate to
make multiple calls to IOCTL_SET_KERNEL_DEV_PORT. For example, the
user might want to associate the debugger with COM1: and associate PPSH with
LPT1:. A KERNEL_PORT_NONE identifier instructs you to disable any service
associations for the specified port.
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Enabling the Service
Once the user has configured each service for the appropriate port, the
IOCTL_OAL_REBOOT I/O controller is used to force a warm boot. Upon
rebooting, the OAL should examine the arguments area that was set by
IOCTL_SET_KERNEL_DEV_PORT. The exact implementation of this will
depend on the ports supported. For example, a CEPC determines which serial
port should be used for initial debugging messages by checking the bootargs
structure in the OEMInitDebugSerial function in the file
Platform\Cepc\Kernel\Oal\X86\Debug.c.

Debugging an Application
This section provides an example of debugging an application using Cesh.exe and
the kernel debugger. To debug the Windows CE OS, you use the Mininput
configuration as a template and the Cepc directory as the platform.

Mininput builds a minimal version of Windows CE with user input support but no
display interface. Instead of sending output to a display, the CEPC keyboard
sends output to the debug serial port. All debugging information then scrolls
down a separate debugging command prompt window on the development
workstation.

The method outlined in this section uses Cesh.exe over a parallel port connection
for communication and uses the kernel debugger for debugging on a CEPC.

IDE Procedures
To build Mininput

To download Mininput and debug using Cesh.exe and the kernel debugger

IDE Procedures
•• To build Mininput

1. Choose New from the File menu.

2. Choose the Platforms tab.

3. Select WCE Platform in the Platforms box, and then enter a name in the
Platform Name box.

4. Select one or more microprocessor in the Processors box.

5. Choose OK to start the WCE Platform Wizard.

6. Select CEPC from the Board Support Package box, and then choose Next.
7. Select Select From Available Sample Configurations, and then select

Mininput from the list.
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8. Choose Finish.
9. Choose OK to create the platform.

10. Choose Settings  from the Platform menu.

11. Choose the General tab and select Debug from the Build Type  list.

This sets the WINCEDEBUG variable to Debug.

12. If you want to change the release directory, enter it in the Release Directory
box.

13. Choose the Environment tab.

14. Select IMGNODEBUGGER in the Environment Variables list, and verify
that the Value box is blank.

15. Choose Set.
16. Select Build Platform from the Build menu.

17. Confirm that the build completed successfully by verifying that the OS image
Nk.bin exists in the release directory

•• To download Mininput and debug using Cesh.exe and the kernel debugger
1. Open Nk.exe as a project in Platform Builder.

2. Choose Debugger Remote Connection from the Build menu.

3. Choose the Settings  button to display the Kernel Debugger Settings dialog
box.

4. Select Serial, and specify either COM1 or COM2 in the Connector list.

5. Select the same baud rate in the Baud Rate list that you will specify on the
CEPC.

6. Choose OK to save the settings.

7. Download Nk.bin using Cesh.exe.

Use the option /c: in the LoadCEPC command line on the CEPC to properly
identify and connect to the debugging ports. As Nk.bin transfers to the PC-
based target device, examine the debug messages scrolling down the
Debugger window.

After Nk.bin downloads, the Cesh.exe debug shell prompt, Windows CE>,
appears in the x86 Build Mininput command prompt build window.

8. View the currently running processes by using the following Cesh.exe
command at the Windows CE debug shell prompt (Windows CE>):
gi proc

9. Start the application Kbdmsg.exe using the following Cesh.exe command at
the Windows CE debug shell prompt:
s kbdmsg
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10. Validate the loading of the Kbdmsg.exe application by pressing any key on the
target platform.

This keyboard input is sent to the debug serial port in the form of VK codes,
which appear in the Debug tab of the Output window.

11. At the development workstation prompt (Windows CE>), type break.

The break command executes a hard-coded breakpoint. The Debug tab of the
Output window displays this message:
Hard coded breakpoint hit

Now you can debug the sample code for Kbdmsg from the development
workstation.

12. After entering break at the prompt, a Source Not Found dialog box may be
displayed in the Debug tab of the Output window. Choose Ignore  in response
to the request to browse for Shell.c.

This is displayed because the process being trapped into is Shell.exe.

13. Before building the code, you may optionally use the DebugBreak function in
the source code.

After running the kernel debugger, execution stops at the DebugBreak
function.

14. Choose Open from the File menu and select Kbdmsg.c.

15. To set additional breakpoints, highlight a line of code and choose the
Insert/Remove Breakpoint button on the Build toolbar.

A red dot appears to indicate breakpoint insertion. Now you can step through
the code. For example, choose Step Over from the Debug menu. Choosing
Debug Windows  from the View menu allows you to evaluate variables and
view other debug-related functions.

16. Choose Go from the Build toolbar or press the F5 key to resume execution of
the Windows CE operating system.

The Windows CE> prompt appears and is available for command input.

Related Topics
Debugging an Application

Using Debug Zones
The Windows CE OS kernel provides support for debugging applications,
including printing debug messages and registering debug zones. Debug zones
allow debugging by enabling macros that control the output of debug messages.

Command-Line Procedures
To use debug zones
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Command-Line Procedures
•• To use debug zones

1. Define and initialize debug zones in the application source code.

For information, see Defining Debug Zones.

2. Declare a DBGPARAM structure in the source code.

For information on the DBGPARAM structure, see Declaring a DBGPARAM
Structure.

3. Call the DEBUGREGISTER macro to register the DBGPARAM structure
with the debug subsystem.

For information on the DEBUGREGISTER macro, see Registering Debug
Zones.

4. Use debug macro calls in the source code to output debug messages.

For information on debug macros, see Calling Debug Macros.

5. Use CESH commands to turn debug zones on or off and to perform other
debugging tasks.

For information on CESH, see Using CESH to Manage Debug Zones.

Related Topics
Using Debug Zones

Defining Debug Zones
To use debug zones, first define each debug zones to a bit mask and initialize it in
the application source code. The API for debug zones is included in the header
file Dbgapi.h. You can define up to 16 debug zones in one application. In the
following example, an application header file defines 16 (0-15) debug zones. The
following code example shows how to associate a bit mask with a debug zone.

#define ZONEID_INIT 0
#define ZONEID_SECOND 1
#define ZONEID_EXCEPT 2
.
.
.
#define ZONEID_ERROR     15

After defining a debug zone to a bit mask, associate a debug zone mask name
with the defined bit mask. A debug zone mask is a named bit mask that is used to
turn a debug zone on or off. The following code example shows how to associate
debug zone mask names with the 16 previously defined debug zones.

#define ZONEMASK_INIT (1<<ZONEID_INIT)
#define ZONEMASK_SECOND (1<<ZONEID_SECOND)
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#define ZONEMASK_EXCEPT (1<<ZONEID_EXCEPT)
.
.
.
#define ZONEMASK_ERROR (1<<ZONEID_ERROR)

Declaring a DBGPARAM Structure
Implement the debug zones and debug zone masks by declaring a DBGPARAM
structure in the source code. DBGPARAM holds the debug output information
by setting the global variable dpCurSettings. The following table shows the fields
defined by dpCurSettings.

Field Description

Module name Looks for zone initialization information in the development
workstation registry

Debug zone name Debug zone name displayed by the control application, such as
CESH. The control application turns the debug zones on or off.

Initial debug zone
mask

Turns on specific debug zones during startup. This is the default
field.

The following code example shows a DBGPARAM structure in the application’s
source code for the previously-defined debug zones and debug zone masks.

DBGPARAM dpCurSettings = {
TEXT("DbgSamp1"), {

TEXT("Init"),TEXT("Seconds"),TEXT("Except"),TEXT(""),
TEXT(""),TEXT(""),TEXT(""),TEXT(""),
(""),TEXT(""),TEXT(""),TEXT(""),
TEXT(""),TEXT(""),TEXT("Warnings"), TEXT("Errors")},
ZONEMASK_ERROR|ZONEMASK_INIT

};

In this example, DbgSamp1 is either a process or module name, followed by the
descriptive names for the 16 debug zones defined in the application’s header file.
These descriptive names are listed in order of their bit position—the debug zone
corresponding to 0x01 is listed first and the debug zone corresponding to 0x8000
is listed last. Two of the 16 debug zones—ZONEMASK_ERROR and
ZONEMASK_INIT—are turned on when the application starts. In the subsequent
output, the words Init and Errors appear, which correspond to the debug zones
ZONEMASK_INIT and ZONEMASK_ERROR.

Registering Debug Zones
After declaring the DBGPARAM structure, call the DEBUGREGISTER macro to
register the structure with the debug subsystem. The syntax for this macro is
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DEBUGREGISTER(hMod|NULL). If you are debugging a .dll file, call
DEBUGREGISTER with the module name. If you are debugging an .exe file, call
DEBUGREGISTER with NULL.

The DEBUGREGISTER macro calls RegisterDbgZones. On the development
workstation, RegisterDbgZones reads the registry key
HKEY_CURRENT_USER\Pegasus\Zones and searches for the module name,
specified in the DBGPARAM macro. If the key exists, RegisterDbgZones calls
SetDbgZone, which uses the stored debug zone mask to update the debug zone
name in the DBGPARAM macro.

In the following code example, the application’s header file includes an ifdef-else-
endif conditional block to define for both retail and debug build conditions. This
block associates the previously defined debug zones with their corresponding
macro names to be used with the DEBUGMSG conditional macro in the source
code.

#ifdef DEBUG
// These macros are used as the first arg to DEBUGMSG

#define ZONE_INIT       DEBUGZONE(ZONEID_INIT)
#define ZONE_SECOND     DEBUGZONE(ZONEID_SECOND)
#define ZONE_EXCEPT     DEBUGZONE(ZONEID_EXCEPT)
.
.
.
#define ZONE_ERROR      DEBUGZONE(ZONEID_ERROR)

#else
// For release configurations, these conditionals are always 0
#define ZONE_INIT       0
#define ZONE_SECOND     0
#define ZONE_EXCEPT     0
.
.
.
#define ZONE_ERROR      0

#endif

The following code example shows how to register the DBGPARAM structure
and define the macros DEBUGMSG and RETAILMSG:

// First, register with the debug subsystem.  For a process, the
// parameter is NULL.  For a DLL, the parameter is hModule.
DEBUGREGISTER(NULL);

// This message shows up in debug configurations only, if
ZONE_INIT is turned on.
DEBUGMSG (ZONE_INIT, (TEXT("DBGSAMP1 starting 1\n")));
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// This message shows up in both debug and release configurations.
RETAILMSG(1, (TEXT("DBGSAMP1 starting 2\n")));

The following code example shows another example of using debug zones.

// Declare a DBGPARAM structure and give names to all used zones.
DBGPARAM dpCurSettings = { L"foodll", {

L"Info", L"Validate", L"bar", L"random",
L"Undefined", L"Undefined", L"Undefined", L"Undefined",
L"Undefined", L"Undefined", L"Undefined", L"Undefined",
L"Undefined", L"Undefined", L"Undefined", L"Undefined" },
0x00000000 };

// Associate bits with a zone. These should correlate
// to the order of the text strings (zone names) above.
#define ZONE_INFO DEBUGZONE(0)
#define ZONE_VALIDATE DEBUGZONE(1)
#define ZONE_BAR DEBUGZONE(2)
#define ZONE_RANDOM DEBUGZONE(3)

// Register : Assume this is a DLL.
// A process would do the same in its libmain.
BOOL DllEntry (HANDLE hinstDLL, DWORD fdwReason, LPVOID lpv) {

if ( fdwReason == DLL_PROCESS_ATTACH ) {
DEBUGREGISTER(hinstDLL);

}
...
}

// Use the defined zone in debug messages
DEBUGMSG (ZONE_INFO, (TEXT("This is a sample message.")));

// Or use a zone as a Boolean operator to turn execution of some
code on and off
if (ZONE_VALIDATE) {

// validate data ...

For more sample code, see the
%_WINCEROOT%\Public\Common\Oak\Demos\Dbgsamp1 directory.

Calling Debug Macros
After the debug zones are registered, use macro calls in the source code to output
debug messages. Release and debug configurations call different macros.

Release configurations use the following macros:

RETAILMSG(cond, printf_exp)
Conditionally displays the print message.
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RETAILLED(cond, parms)
Conditionally outputs WORD values to the LED.

ERRORMSG(cond, printf_exp)
Prints Error: File Line before the print message.

Note
To enable the debug macros, build a debug configuration. Set the WINCEDEBUG
environment variable before building the code: set WINCEDEBUG=debug.

Debug configurations use the three retail macros as well as the following debug
macros:

DEBUGMSG(cond, printf_exp)
Conditionally displays the print message.

DEBUGLED(cond, parms)
Conditionally outputs WORD values to the LED.

DEBUGCHK(expr)
Asserts the expression. If the expression is FALSE, the macro calls
DEBUGBREAK.

DEBUGZONE(zone_id)
Tests the mask bit in the current debug zone settings. You can use
DEBUGZONE to turn debug zones on or off.

Using CESH to Manage Debug Zones
Use the Cesh.exe command gi to obtain useful debugging information. Use the
Cesh.exe command zo to turn debug zones on or off by modifying bits of the
registered debug zone mask.

The following are examples of using Cesh.exe commands to manage debug
zones:

gi proc
Displays information about running processes.

zo p 2
Displays the zone names for the process at index 2.

zo m 0 0x100
Sets the zone for the module at index 0 to 0x100.

Related Topics
Using Cesh.exe Debugging Commands.

Using the Windows CE Debug Shell Tool.



Chapter 1    Chapter Head  27

Copyright © 1999 Microsoft Corp
Page 27 of 27

Using the Windows CE Debug Shell Tool
The Windows CE debug shell tool, Cesh.exe, acts as a remote debug shell that
loads and launches files from the development workstation to the target device.
To use Cesh.exe, first connect to the target device.

Platform Builder provides methods for connecting the development workstation
to the target device using an Ethernet connection or a parallel port.

Using only Cesh.exe for debugging, you can do the following:

• Start and add files.

• Examine the status of processes and threads.

• View and modify debug zones.

When a thread is waiting for a critical section and is blocked, you can use the gi
command (get information) from the Cesh.exe prompt Windows CE> to
determine which threads are blocked and which thread is owned by a critical
section. To determine which threads are blocked, enter gi all at the Windows
CE> prompt. The output shows a listing of all the blocked threads.

Command-Line Procedures
To troubleshoot a target device that appears to stop respondingRelated Topics
Windows CE Debug Shell Tool

Command-Line Procedures
•• To troubleshoot a target device that appears to stop responding

1. Determine if Cesh.exe is responding by pressing Enter in a console window.

If the prompt returns, the target device is still responding; the processes are
just blocked.

2. If you can, type gi all at the command prompt.

This will display information about the state of system processes and threads.
See Debugging Processes and Threads.

3. You can get into the debugger by typing break at the Windows CE> prompt.

4. If Cesh.exe does not respond, press the Halt button on the target device.

5. Choose Processes from the Debug window to display process information.

Related Topics
Using the Windows CE Debug Shell Tool
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